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This document gives the features available to the Administrator of BOLTPlus on Web 
Application. The features covered here are User Administration, Security, Contract 
Administration, Monitoring Positions and Margins of Users, Maintaining Limits, Margins and 
Trading Rights for Users for BSE, NSE, MCX & NCDEX. 
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Admin Interface: 

Admin> Users: 

 

 

Existing User Search: 

This option helps the admin to search all users / login id created on BOLTPLUS. 

Users can be searched on basis of Name, Login Id, Status, Owner Login id. 
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Get User Detail: 

After entering the User details like Name, Login Id, Status, Owner Login id, click on Get User 
Detail to get the User definition on the Right side of the window. 

This is helpful in determining the User rights and editing the user details if required. 

New User Creation: 

 

 

How to Add a New User: 

Admin > Users > User Details 

Click on Add to Activate User Addition Window. 

Owner Login id:  Click on “+” – to select the Owner Login id. 

User Login Id: This is the UCC code or Client login id 

Status:  Status can be selected as Active / inactive / Suspended as per requirement 

Note: 

In case of an existing user id, if the Password is entered wrong/incorrect 3 times the id will 
be suspended. 
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Type:  types of Users are User / Employee / NRI / Profile  

If the user is an end client it is to be selected as an User 

If the user is a Dealer / Multi code it is to be selected as an Employee. 

If the user is an NRI Client it is to be selected as an NRI 

Note: 

Incase a set of similar permissions are to be assigned to a group of users, User type 
“PROFILE” is created and attached to End Users. Profile creation has been detailed below in 
this manual. 

Password / Transaction / Mobile Password: All the three are mandatory fields while 
creating any type of user. 

When the user logs in using the first time password, user will be prompted to change the 
same. Also, every 14 days users will be prompted to change their password mandatorily by 
the system. 

First Name / Middle Name / Last Name:  These are the details of the user to be updated 
for creation of users 

Mobile Number / Salutation / Pan Card Number:  These are the details of the user to be 
updated for creation of users 

Email: This field is to be filled in case the User is to be allowed to login and trade Online. 

An Unique Authentication Image is sent to the users registered email Id, which is used in 
login by the user. (User has to click on get authentication image option to receive the same). 

Set Default MarketWatch: This option sets a default MarketWatch/Touchline for the User. 
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New User Permissions: 

Allow Login through Web:  to be checked if login through Web to be provided 

Allow Login through Thick Client: to be checked if login through Exe to be provided 

Allow Login through Mobile: to be checked if login through Mobile to be provided 

Allow Pro-Client: To be given to User / Dealer, dealing in Proprietor trades 

Speculative User:  To be given to User who would be allowed intra- day trading. 

Institutional Dealer: To be given to Dealer involved in Institutional Trading. 

Institutional Client: To be given to Institutional Client. 

Check Group Margin: To be given to Dealer/User where the trading in group of users is to 

be limited by a Margin Restriction over the group as a whole. 

Use Var Margin (Equity): To be given to users where Margin calculation is to be done on 

VAR basis. 

Use User Margin: To be given to users where Margin calculation is to be done on User basis. 

(Contract margin field also to be updated for the above permission) 

Use Highest (Equity): To be given to users where Margin calculation is to be done on the 

highest among VAR Or User defined Margin. 

(Contract margin field also to be updated for the above permission) 

Use Span Margin (Derivatives/Commodities/Currency): To be given to users where 

Margin calculation is to be done on Span Margin. 

Use Span Margin + Exposure (Derivatives/Commodities): To be given to users where 

Margin calculation is to be done on Span + Exposure. 

Block Trading on MTM Cut Off: This option would block the trading of the user incase the 

MTM exceeds the Set percentage and would allow only square off orders. 

The User would have to be removed from the Blocked users list to enable / activate for 

normal trading. 
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Give Credit for Delivery Sales: This option is provided if the DP holdings of the User has 

been uploaded using the Upload facility provided. 

Once this option is selected the user would get the credit/deposit for the sale of holdings in 

the users DP uploaded on BOLTPLUS. 

The Admin can select the DP holding to be uploaded for any User. 

Donot Check Deposit for User:  Once this option has been selected, the RMS check would be 

removed and trading would be allowed unrestricted. 

PERMISSION TABS: 

 

User Info: 

In this section the User Details and Permissions are updated as above. 

Contract Margin: 

Admin>Users>Contract Margin 

In this section the User Margin can be defined for the User in the Equity segment. 

Intraday and Delivery margin can be defined percentage wise. 

Contract margin can be defined for individual Scrips also, along with common margin to be 

blocked in case of other scrips. 
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Mark to Market: 

Admin>Users>Mark to Market 

In this section MTM for Users can be defined along with warnings for the User before the 

MTM triggers. 

Cut off level indicates the final MTM percentage of the Actual deposit defined for the user in 

Admin > User Deposit. 

 

 

Trading Rights: 

Admin>Users>Trading Rights 

In this section, the trading rights for the user can be defined. 

 

The following trading rights can be setup: 

1. For Self 

a. Can Enter Buy Order 

b. Can Enter Sell Order 
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c. Can Modify Order 

d. Can Cancel Order 

e. Can Square Off Orders 

2. For Others 

a. Can Enter Buy Order 

b. Can Enter Sell Order 

c. Can Modify Order 

d. Can Cancel Order 

e. Can Square Off Orders 

3. Allow Pro Orders 

4. Allow Broadcast 

 

These options can be set up at the following levels: 

1. For a User for a Contract/Security in an Exchange – This is the finest level at which one 

can set trading rights. This can be used to disable a user in a particular Contract or 

Security in a particular Exchange. 

2. For a Security/Contract in an Exchange – When the trading rights are set at this level 

then it applies to all the users. Thus if it is desired to disable trading in a particularly 

volatile security from trading then  Trading Right can be setup with nothing enabled for 

this Security. 

3. For a User for a Contract/Security– This is the finest level at which one can set trading 

rights. This can be used to disable a user in a particular Contract or Security in all the 

Exchanges. 

4. For a User in a Segment in an Exchange – We can use this to disable the user from trading 

in a particular Segment within an Exchange. A Segment could be one of the following: 

a. Equity 

b. Futures – Equity , Currency & Commodities 

c. Options – Equity & Currency 

5. For a Segment in an Exchange - We can use this to disable all the users from trading in a 

particular Segment within an Exchange. 

6. For a User in a Market in an Exchange – We can use this to disable the user from trading 

in a particular Market within an Exchange. A Market could be one of the following: 

a. Equity 

b. Derivatives 

c. Currency 

d. Commodities 
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7. For a User in a Market in an Exchange – We can use this to disable all the users from 

trading in a particular Market within an Exchange. 

8. For a User in a Segment– We can use this to disable the user from trading in a particular 

Segment across all Exchanges. 

9. For a Segment - We can use this to disable all the users from trading in a particular 

Segment across all Exchanges. 

10. For a User in a Market – We can use this to disable the user from trading in a particular 

Market across all Exchanges. 

11. For a User in a Market – We can use this to disable all the users from trading in a 

particular Market across all Exchanges. 

12. For a User in an Exchange – We can use this to disable the user from trading in a 

particular Exchange. 

13. For an Exchange – We can use this to disable all the users from trading in a particular 

Exchange. 

14. At the System Level – We can disable all the users for any action, across all exchanges and 

segments. 

A negative condition in any applicable path will stop the order from being accepted even if it 

is marked to be allowed at any other level. 

E.g. even if the user has been explicitly enabled for trading in a particular Security, if it has 

been disabled for a particular Exchange across users the user will not be allowed to place the 

order. 

Right Limits: 

Admin>Users>Right Limits 
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RIGHT LIMITS / USER LIMITS 

Trade Turnover Limit: 

 Total value of BUY trades and SELL trades. 

 In case the limit is utilized and pending trades are to be squared off, additionally limit 
will need to be assigned. (Square off trades are not allowed over and above the 
provided limits) 

 The restriction of the limit is not applicable to the Pending Orders or Order placement 

E.g. 

Trade Turnover Limit Rs 100.00, 

Total Buy Trades Rs. 80, Total Sell Trades Rs. 10 

As of Now Trade Turnover Limit used – 80+ 10 = Rs 90 

Pending Orders – No Restriction 

 

Additional Sell Trade for Rs.10 executed 

Trade Turnover Limit Used Rs 100. 
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New Orders – Not allowed as Trade Turnover Limit fully utilized. 

Pending orders will not be cancelled automatically. 

Open Position: 

Buy Rs 80 + Sell Rs 20 = Rs 100.00 

If User wants to square of Rs 60 worth of Buy Trades, user will have to be assigned an 
additional limit of Rs 60.00. 

Trade Turnover Limit will have to be set as Rs 160 (100+60). 

Total Turnover Limit:  

 Total value of BUY Trades + SELL Trades + BUY Orders + SELL Orders 

 In case the limit is utilized and pending trades are to be squared off, additional limit 
will be needed to be assigned. (Square off trades are not allowed over and above the 
provided limits) 

E. g., 

Trade Turnover Limit Rs 100.00,  

Total Buy Trades Rs. 70, Total Sell Trades Rs. 10  

As of Now Trade Turnover Limit used – 70+ 10 = Rs 80 

Pending Orders – Allowed upto Rs 20 (100-80) 

Additional Sell Trade for Rs.10 executed 

Trade Turnover Limit Used Rs 90 (80+ 10) 

 Orders – Allowed upto Rs 10 (100-90) 

Open Position: 

Buy Rs 70 + Sell Rs 20 = Rs 90 

Pending Orders – Allowed upto Rs 10 (100-90) 

If User wants to square of Rs 50 worth of Buy Trades, user will have to be assigned an 
additional limit of Rs 40 (50-10). 

Trade Turnover Limit will have to be set as Rs 140 (100+40). 
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Trade Buy Amount: 

 Total value of BUY Trades only 

 There is no restriction on the Orders which can be placed by the user .Once the user 
crosses the Threshold limit of the buy trade amount, new orders will not get placed. 

E. g., 

Trade Buy Amount Rs 100.00,  

Total Buy Trades Rs. 70 

As of Now Trade Buy Amount used = 70 

User can place a new Order of any amount 

Pending Buy Orders Allowed = No Restrictions 

 

Additional Buy Trade for Rs.30 executed 

Trade Buy Amount Used Rs 100 (70+ 30) 

Pending Buy Orders Allowed – None as Trade Buy Amount fully utilised. 

 

Trade Sell Amount: 

 Total value of SELL trades only 

 There is not restrictions on the Orders which can be placed by the user . 

 Once the user crosses the Threshold limit of the Sell trade amount, new orders will not 
get placed. 

E. g., 

Trade SELL Amount Rs 100.00You can place Sell order upto Rs.100 Only 

Total SELL Trades Rs. 70 

As of Now Trade SELL Amount used = 70 

Pending SELL Orders Allowed = No Restrictions 
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Additional SELL Trade for Rs.30 executed 

Trade SELL Amount Used Rs 100 (70+ 30) 

Pending SELL Orders Allowed – None as Trade SELL Amount fully utilized. 

  

Total Buy Amount: 

The limit is equal to the Total no. of Buy Orders + Buy Trades 

If Buy Trade value is partially used then remaining value can be used for  placing pending 
Buy orders only up to the remaining limit. 

 

E. g., 

Total Buy Amount Rs 100.00 

Total Buy Trades Rs. 70 

As of Now Total Buy Amount used = 70 

Pending Buy Orders Allowed = Rs 30.00 (100-70) 

If Additional Rs 30 Buy Trades executed. 

Pending Orders would not be allowed. 

Total Sell Amount: 

 The limit is equal to the Total no. of Sell  Orders + Sell Trades. 

  If SELL Trade value is partially used then remaining value can be used for placing 
pending Sell orders only up to the remaining limit. 

E. g., 

Total SELL Amount Rs 100.00 

Total SELL Trades Rs. 70 

As of Now Total SELL Amount used = 70 

Pending SELL Orders Allowed = Rs 30.00 (100-70) 
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If Additional Rs 30 SELL Trades executed. 

Pending Orders would not be allowed. 

Buy Outstanding Amount: 

 Total Value of Pending Buy Orders allowed at any given point of time. 

E. g, 

Buy Outstanding Amount Rs 100.00 

Pending Buy Orders Rs. 70 

As of Now Buy Outstanding Amount used = 70 

Pending Buy Orders Allowed = Rs 30.00 (100-70) 

Sell Outstanding Amount: 

 Total Value of Pending Sell Orders allowed at any given point of time. 

E. g. 

Sell Outstanding Amount Rs 100.00 

Pending Sell Orders Rs. 70 

As of Now Sell Outstanding Amount used = 70 

Pending Sell Orders Allowed = Rs 30.00 (100-70) 

Max Order Qty: 

Single Order Maximum Qty can be defined here for users. 

User can place multiple orders with the Max Order Qty until the limits are available. 

Max Order Value:  

Single order Maximum Order value can be defined here for users.  

User can place multiple orders with the Max Order Value until the limits are available. 
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User Profile: 

Admin>Users> 

PROFILE CREATION: 

Go to path: 
 
Admin> Users> Click on Add 
 
The Login Id will be the Profile name, Status as Active & Type as Profile. 
 
Please note that no Permissions should be defined while creating profile. 
 
The various profile definitions which are possible are Contract Margin Profile, Mark to Mark 
Profile, Trading Rights Profile, Rights Limits Profile, IP Address Profile, User Configuration 
and User Exchange Identifier. 
 
We will discuss one sample example of Profile definition in the following section. The other 
profile definition for others will also be on similar lines 
 

e.g., CONTRACT MARGIN PROFILE: 

We will create a profile with Intraday Margin as 25 % and Delivery margin as 100 % 
 
Step 1 – Populate the definition of user as explained in the earlier sections. Add the name 
according to the requirement e.g. Contract_Margin_HO 
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Step 2 - Go to Contract Margin tab 
 

 
 

1. Exchange – The Profile can be created for an exchange. Multiple records are 
permitted when creating a Profile. 

2. Market - The Profile can be created for the Market Equity. Multiple records are 
permitted when creating a Profile. 

3. Segment - The Profile can be created for the segments equity. Multiple records are 
permitted when creating a Profile. 

4. Intraday Margin Type – This is the margin to be applied to the user when the user 
places an intraday order, which will be squared off the same day. 

5. Delivery Margin Type - This is the margin to be applied to the user when the user 
places a Delivery order, and is looking forward to carry over the position to a 
future date. This will be applicable only for the Equity markets. 

6. Value – This is the Percentage that will be applicable every order placed by the 
user for Intraday trading purpose. 
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7. Delivery Value - This is the Percentage that will be applicable every order placed 
by the user for Delivery purpose. 

8. Save – Once the user wants to save this record, the user clicks on “Save”. 
9. Cancel – If the user does not want to save the record, the User can click on “Cancel” 

 
We are done with the creation of this profile. 
 
Profile Attachment: 
 
Go to Admin > Users > 

Get User Info > Click on User Profiles > 

 

 

Attach the Contract Margin Profile by clicking on the button shown by the arrow above. 

Note : One profile every permission, can be attached at a time 

User Exchange Identifiers: 
Admin>Surveillance>NNF/Location Id: 

This allows the user to maintain the Exchange Identifiers of users.  
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BSE has NNF Id of 16 Digits in length.  

 

NSE has NNF Id of 15 Digits in length.  

Exchange identifiers /NNF/ location ids have to be updated as per exchange requirements. 

Once updated in Exchange systems, it can be updated in BOLTPlus on web as shown above. 
 

IP Address: 

Admin>Surveillance>IP address 

 

This facility allows the administrator to restrict users to access the application only from a 

pre defined range of IP addresses.  

The IP can be specified as a range.  

For internet users one may wish to give the entire range of IPs by specifying 0.0.0.0 to 

255.255.255.255.  

It is possible to have one or more range enabled or disabled for a user. 
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 If a particular IP range is restricted in one range and enabled in another range for the same 

user, it will be considered restricted. 

Employee Users: 

Admin>Employee Users  

The Users of type Employees cannot trade by default for any user. They have to be associated 

to a list of users for whom they can trade. This Administrative screen facilitates the linking of 

Employee type users to users/end clients for whom they can trade. 

A user can be at an instance associated to multiple numbers of Employees. 

 

The screen as can be seen is split into four Lists. 

The first list is the list of Employees. 

The Second List is the list of users presently associated with the selected Employee User. 

The Top portion of the Third List is the list of users removed from the Employee in the 

current Session. 

The Lower portion of the Third List is the list of users being added to the Employee in the 

current Session. 

The Fourth is the List of users which can be searched for to be added to the Employee user. 
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Deposits: 

Admin>surveillance>User Deposits 

This section can be used to setup deposits for users at different levels. In the application it is 

mandatory for all the users to have some deposit to trade. If no deposit is set for a user then 

the user cannot trade. 

Why Deposits? 

Deposits are used for checking the margins to be levied on the user. The margins are 

calculated for individual securities. They are totaled at the level at which a deposit amount 

has been specified and a check is made at this level to see if there is sufficient deposit before 

the order request is forwarded to the Exchange. The only condition under which orders are 

forwarded to the exchange even if there are insufficient Deposit is if the order being entered 

happens to be a square off order as per the existing net position of the user in the security. 

Under this case the order is forwarded to the exchange as if this order executes it should 

reduce the margin requirements. 

Levels 

For different users the deposit can be setup at different levels.  

User Level Deposit: 

In this case only one comprehensive deposit amount is specified for the user and checking of 

the margins for users for order in any Exchange, Market, and Segment is checked against 

this amount. 

Other Level Deposits: 

Securities 

Security: One Single Deposit is used for all trading in Securities 

User - Exchange: In this case the deposit is specified for the user specific to the Exchanges. 

Thus there could be a deposit for the User for BSE, and a deposit for NSE and one for MCX. 

User - Exchange - Market: In this case the deposit is specified for the user specific to the 

Exchanges in a particular Market. Thus there could be a deposit for the User for BSE for 

Equities Market, and a deposit for NSE in Derivatives Market and MCX commodities. 
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User - Exchange – Market - Segment: In this case the deposit is specified for the user specific 

to the Exchanges in a particular Segment. Thus there could be a deposit for the User for BSE 

for Equities Segment, and another deposit for BSE in Futures Segment and another deposit 

for BSE in Options Segment and so on. 

User - Market: In this case the deposit is specified for the user specific to the Markets across 

the Exchanges. Thus there could be a deposit for the User for Spot Market, and another 

deposit for Derivatives Market and so on. 

User - Market - Segment: In this case the deposit is specified for the user specific to the 

Segments across the exchanges. Thus there could be a deposit for the User for Options 

Segment, and another deposit for Futures Segment and so on. 
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List Login Info: 

Admin>Surveillance>ListLoginInfo: 

This allows the Administrator to view the list of users currently logged into the system. 

Details of User Login id ,IP address , type of login & login time is available. 

 

Send Message: 

Admin>Messages>Send Messages: 

This facility can be used to send messages to the users logged in the system. The message can 

be sent to a single user or to a group of users or to all the users. These messages will be seen 

by the user only if the user is logged in at the time when the message is sent. If the user is not 

logged in they will not be prompted for the message when they login later. The list of 

messages sent to a user can always be seen from the List Messages for users in the 

application. 

The Administrator can send messages to any user in the system. The Group leader can send 

messages to the users under him/her. Similarly an employee can send messages to the users 

associated to him/her. 
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Margin Summary: 
Admin>Surveillance>Margin Summary: 

 

This screen gives the summary of Margins that has been blocked for the different users. It is 

possible to see the summary for all the users in the system in this screen. The Mark to Market 

(MTM) figures for the user is also displayed.  

Based on the information displayed in this screen the administrator can decide to square off 

all positions of selected users or of all the users if so desired. The administrator can also 

cancel the orders of selected users or all orders of all the users. 
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MARGINS: 
 

The report provides the Admin, usage of any particular user in terms of usage of 

Margins/Deposit. Also, it provides the admin the details the margins/ deposit utilized for the 

same. 

 

DOWNLOAD TRADES: 
Tools>Download>Download Trades 

This option allows the Admin to download all the orders placed in the system and save the 

same in a   .csv format. 

 

 Login/Id – If this is left blank then trades for all the users will be downloaded. 

If the same has to be downloaded for a particular user then the user id can be selected and 

the record will be generated. 

 EXCHANGE – The Exchange can be selected for which the trades are to be 

downloaded. 
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 MARKET – This will include the various markets like Equity, Derivatives, Currency, 

and Commodities. 

DOWNLOAD ORDERS: 
Tools>Download>Download Orders 

This option allows the Admin to download all the orders placed in the system and save the 

same in a (.csv) format. 

 

Login/ID– If this is left blank then orders for all the users will be downloaded. 

If the same has to be downloaded for a particular user then the user id can be selected and 

the record will be generated. 

EXCHANGE – The Exchange can be selected for which the orders are to be downloaded. 

MARKET – This will include the various markets like Equity, Derivatives, Currency, and 

Commodities. 

MTM BLOCKED USER REPORT: 
Admin> Surveillance > MTM User (Blocked) 
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This option gives a list of users who are blocked due to Mark to Market reason. 

Also, the user who are blocked can be Unblocked using the same window. 

1. View Blocked Users – The report gives the list of users who have been blocked due to 

MTM. 

2. Unblock Users – If any user who is blocked to be removed from the block list then this 

option is used. 

The procedure to unblock any user(s) is as below: 

1. Select the user(s) to be unblocked. 

2. Once the user(s) has been selected click on Unblock Users, and a pop-up will be 

displayed, to proceed with Unblocking press “Yes” or else press “NO”. 

3. After clicking Yes, the system displays the message to delete the Trading rights 

as when the MTM is hit the system automatically inserts a new Trading right 

record to block the user from Trading, except for squaring off his/her open 

positions. 
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ADMIN REPORTS: 

Admin> Surveillance > Admin Report 

Go To Admin > Surveillance> Admin report 

These reports help the Admin to check on the activity on the various critical components of 

the Trading Platform. 

These reports have the admin id who has affected the changes and also the User id which 

have been affected by it. Also the Date and time stamp is reflected on these reports. 

As shown below: 

Select the Report to be generated and click on View Report: 

 

 

Select the report from the Activity Log type 

 

 

And press View: 

The details of the report will be displayed. 
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View Pending orders: Order Book 
View > Order Book 
 

 

The list of pending orders with the details like Symbol, Quantity, Price, Buy/Sell, Order No, 

Exchange, Client ID, User/Admin ID, time of order, etc. can be viewed from here. 

Right click on the order book- Select Columns - enables the admin to view additional fields by 

selecting the required columns.  

The order details can be saved in text file. 

The admin is also provided with the flexibility to select and position the column according to 

choice. Right Click on the Order book , Chose the option ”Select Column” .This will open a 

window showing the list of columns available for selection. Use the “UP” and “DOWN” Arrow 

keys to change the positioning of the columns.  

After selection of the columns, click on “Save” button to save the changes. 
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The Search Panel helps the Admin to filter down to the finest level of details of the pending 

orders. 

The orders can be filtered from Exchange/ Market/Segment to Login id / Symbol/ series 

/inst. Name/ Expiry/ Opt. Type. 

Also, the orders can be filtered for the type of Orders like – Buy /Sell, Intraday/ Delivery. 

If any kind of Batch orders is to be sent to the exchange, the same are uploaded using the 

Bulk order facility online and the same can be viewed from the Batch Orders dropdown and 

then released, one by one or all at a time. 

Alternatively the admin can right click on the scrip in the Marketwatch and select the below 

option view order details for <Scrip/Contract> 

 

View Executed Trades: Trade Book 
View > Trade Book 
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The list of traded/Executed orders with the details of Symbol, Quantity, Price, value Buy/Sell, 

Order Number, Trade Number, Exchange, User ID, time of trade is available in this book. 

Right click on the Trade book - Select Columns - enables the user to view additional fields by 

selecting the required columns. All the details can be saved in a Text file or exported to an 

Excel. 

Admin is also provided with the flexibility to select and position the column according to 

choice. Right Click on the Trade book , Chose the option ”Select Column” . 

This will open a window showing the list of columns available for selection. Use the “UP” and 

“DOWN” Arrow keys to change the positioning of the columns. After selection of the columns, 

click on “Save” button to save the changes. 

 

The Search Panel helps the admin to filter down to the finest level of details of the executed 

orders.The trades can be filtered from Exchange/ Market/Segment to Login id / Symbol/ 

series /inst. Name/ Expiry/ Opt. Type. 

The trades can be filtered for the type of Orders like – Buy /Sell, Intraday/ Delivery. The 

admin is also provided with the option of filtering the Trades in a Time Range. 

Alternatively the admin can right click on the scrip in the Marketwatch and select the below 

option view trade details for <Scrip/Contract>: 

 

View Net Position: Net Position Book 
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View > Net Position 

 

F9 will display the Net position for users in the scrip’s/ contracts in which Trades has been 

done or have brought forward positions in the same. 

This report provides the admin with its Net Position in the system. The same details can be 

filtered down to multiple layers as shown above. The Net Position book can be divided into 

sections like Search panel and View panel. 

 

View Panel – This option reflects the days Open Positions brought forward & carry forward 

positions (Click on the Respective tick box).  

It shows the day’s open position with the details of client, symbol, buy quantity, average buy 

price, buy value, sell quantity, average sell price, sell value, current market price, Mark to 

Market, Profit/Loss.  

If the User setting is set to Auto Refresh, then the Admin will be able to view the Net position 

along with the MTM+PL, CMP on a live basis. 
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The user is also provided with the flexibility to select and position the column according to 

user’s preference. Right Click on the Net position book, Chose the option “Select Column”. 

This will open a window showing the list of columns available for selection. Use the “UP” and 

“DOWN” Arrow keys to change the positioning of the columns. After selection of the columns, 

click the “Save” button to save the changes. 

The Search Panel helps the admin to filter down to the finest level of details of the Net 

position of User(s).It can be filtered from Exchange/ Market/Segment to Login id / Symbol/ 

series /inst. Name/ Expiry/ Opt. Type. The trades also can be filtered for the type of Orders 

like – Buy /Sell, Intraday/ Delivery. 

  

Brought Forward – These are the positions that are being brought forward from the 

previous trading days. It will be visible only if the positions of the users from the previous 

days are uploaded. 

Days Position – These are the intra-day positions taken by the user. 

Carry forward – This indicates the Net position of the user in the particular scrip / contract 

whether it is net long or net short. 

Alternatively the user can right click on the scrip in the Marketwatch and select the below 

option view Net Position details for <Scrip/Contract> 

 

View Activity Log: Activity Log 
View > Activity Log 
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This report provides the admin with the Log of all the activities carried out. This includes- 

order confirmation, rejection, cancellation of orders, Trade confirmation and the rejected 

orders of all types with the reject reason. 

This Allows admin to View the list of activity at any given time during the day by with details 

of  Symbol, series, Order Number, Volume, Buy/Sell, Trigger Price, Activity, Time, Intra/Del, 

User ID, account Type. 

Right Click on the screen - Select Columns - enables the user to view additional fields by 

selecting the required columns. The activity log details can be saved in text file or the same 

can be exported to an Excel sheet. 

 

The Search Panel helps the admin to filter down to the finest level of details of the Activity 

Log of User(s). 

The orders can be filtered from Exchange/ Market/Segment to Login id / Symbol/ series 

/inst. Name/ Expiry/ Opt. Type.  

Also, the trades can be filtered for the type of Orders like – Buy /Sell, Intraday/ Delivery.  

The user can specifically view only the Rejected Orders by clicking on the Rejected orders 

option on the Search Panel. 



                                                                                                               

38 

 

Market Depth: Best 5 

View >Market Depth 

The User will be able to get the BEST 5 prices in the market for the scrip selected. 

It will provide the admin apart from the BEST 5, other important details like LTP, LTQ, 

Volume, Value, ATP (Avg. Traded Price), DPR ( Daily Price Range), Chg, Open , High, Low, % 

Chg.  

 

 

 

 

In case scrip is not added in the Market watch, the user can enter the symbol, Symbol code in 

the Symbol/Script space and Press enter, and the user would receive the details for that 

particular scrip. 

And if the admin wants to place the order in the same scrip, user can use the order entry keys 

to the orders directly in the selected scrip of the MBP without adding it to the Market watch. 
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Net Position (Trade Wise): 

View > Net Position (Trade Wise) 

Incase the user is facing issues in viewing the Net Position from F9 / Net position, user can 

use this alternate option where Net position is provided as a summary/view of the Trade 

Book. 

 

 

INSTITUTIONAL TRADES 

User Ids and Permissions required for Institutional Trade on BOLTPLUS: 

The user will not be able to see the INST flag till the user is defined as an Institution Client: 

Ids to be created on BOLTPLUS: 

Dealer ID 

Institutional ID 

Permissions to be given on BOLTPLUS: 

Dealer 
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Institution Client Code: 

 

While Placing Orders: 

Enter the Quantity and Price Selection of the INST flag is compulsory along with the Client 
Code 

 

Enter the Quantity and Price. Selection of the INST flag is compulsory along with the Client 
Code 

 


